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IP Facts

Introduction

The Xilinx® Partial Reconfiguration Decoupler
can be used to provide a safe and managed
boundary between the static logic and a
Reconfigurable Partition during Partial
Reconfiguration,

The core can' be customized for the number of
interfaces, typewof.interfaces, decoupling
functionality, status and control.

Features

« All Interface types registered in the
Vivado® Design Suite are supported,
including custom interfaces.

« Non-Vivado Design Suite interfaces are
supported.

« Multiple interfaces per decoupler instance.

« The decoupling behavior can be configured
for each interface.

« Each interface can have Clock Domain
Crossing support.

« Optional Signal based control.

« Optional Signal based status.

« Optional AXI4-Stream based control.
« Optional AXI4-Stream based status.

« Optional AXI4-Lite based status and
control.

PR Decoupler v1.0

LogiCORE™ IP Facts Table

Core Specifics

UltraScale+™ Families,

UltraScale™ Architecture,

Virtex®-7, Kintex®-7, Artix®-7,
Zynq®-7000 All Programmable SoC

Supported
Device Family()

supported User AXI4-Lite, AXI4-Stream

Interfaces

Resources Performance and Resource Utilization web page
Provided with Core

Design Files Encrypted RTL

Example Design Not Provided

Test Bench VHDL

Constraints File Xilinx Design Constraints (XDC)

Simulation
Model Source HDL
Supported
S/W Driver N/A

Tested Design Flows(2)

Design Entry Vivado Design Suite

For supported simulators, see the

Sirgfation Xilinx Design Tools: Release Notes Guide.

Synthesis Vivado synthesis

Support

Provided by Xilinx at the Xilinx Support web page

www.Xilinx.com

Notes:

1. For a complete/list of supported devices, see the Vivado IP
catalog.

2. For the supportedversions of thetools, see the
Xilinx Design Tools: Release Notes Guide.
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Chapter 1

Overview

One or more Partial Reconfiguration (PR) Decoupler cores can be used to make the
interface between a Reconfigurable Partition and the static logic safe while Partial
Reconfiguration is occurring. When active, user-selected signals crossing between the
Reconfigurable Partition and the static logic are driven to user configurable values. When
inactive,signalsare passed unaltered.

Feature Summary

Interface Aware

The PR Decoupler is interface awaré to'make it faster to connect to standard interfaces.

Multiple Options for Status and-Control

The PR Decoupler can be controlled and queried dsing single signals, an AXI4-Lite interface,
or AXI4-Stream interfaces. Any combination ofthesednterfaces can be enabled at the same
time.

Clock Domain Crossing

The PR Decoupler inserts clock domain crossing synchronizers if requested to manage
decoupled interfaces which run from a different clock than the core’s control interface.
Works with Partial Reconfiguration Controller

The PR Decoupler connects directly to the Partial Reconfiguration Controller using the
signal based control interface. More information about this core is available in the Partial
Reconfiguration Controller LogiCORE IP Product Guide (PG193) [Ref 1].
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Unsupported Features

The PR Decoupler should not normally be configured using the Vivado® Design Suite
set_property command. Instead, a custom set_property command is provided with
the core. For more information, see Configuring the Core Using Tcl Commands. The
exceptions to this are bus interface parameters, such as reset polarity and clock FREQ_HZ,
which can be set using set_property.

Licensing and Ordering Information

ﬁ IMPORTANT: [n theVivado Design Suite, the Partial Reconfiguration flow requires a license. Contact
your local sales offices for pricing and ordering details [Ref 2].

IP License Type

This Xilinx® LogiCORE™ IP'moduletis provided at no additional cost with the Xilinx Vivado
Design Suite under the terms<of the Xilinx End User License. Information about this and
other Xilinx LogiCORE IP modules’is available at the Xilinx Intellectual Property page.

For more information, visit the PR Decouplérproduct page.
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Chapter 2

Product Specification

Introduction to Decoupling

The Problems that Decoupling Solves

Designers of partially reconfigurable systems must consider several effects that can occur
when reconfigurableimodules are used.

« Undesirable values'driven.into the static logic: Signals driven by resources in the
Reconfigurable Partition that is undergoing reconfiguration might take on undesirable
values, namely:

- They might glitch.

o They might be driven to 1 by'the interconnect which is undesirable if the signal is an
active-High control signal.

o They might be driven by a Reconfigurable‘Module that has not been reset and is
therefore in an unknown state

+ Corruption of the new Reconfigurable Module: Signals driven by the static logic into
the Reconfigurable Partition that is undergoing reconfiguration can cause the newly
loaded Reconfigurable Module to become corrupted. For example:

- Spurious writes to memories can occur.

- Parts of the reconfigurable module can start to operate while other parts do not.
This can occur even with RESET_AFTER_RECONFIG because the GWE (Global Write
Enable) signal is asynchronous to the user clock, so it could write enable parts of
the new Reconfigurable Module in one user clock cycle but leave other parts write
disabled.

If any of these effects are problematic for a design, you can use decoupling logic to manage
the signal values on the boundary between the static logic and the Reconfigurable Partition
that is undergoing reconfiguration.
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Guidelines for Decoupled Signals

The signals that need to be decoupled are design-specific, and the following guidelines are
recommended:

« Decouple all control signals generated from the Reconfigurable Partition.

« Decouple all control signals driven into the Reconfigurable Partition if the
Reconfigurable Module being loaded cannot be fully reset before operation.

« If a Reconfigurable Module has logic that can start to execute without being qualified
by a découpled control signal, consider decoupling the appropriate input clock.

Operation

Figure 2-1 showssa simple decoupler that decouples a single signal.

*  When the decouplesinput'is 0, the rp_A input is passed unchanged to the s_A output.

«  When the decouple input.is 1,the rp_A input is decoupled from the s_A output, and s_A
is driven to a constant value.

\

p_A

0—™

decouple

X14894-082115

Figure 2-1: A Simple PR Decoupler

Configuring a PR Decoupler to decouple the static from a Reconfigurable'Partition can be
time consuming when done one signal at a time, so the PR Decoupler IP has been designed
to be interface aware.

According to the Vivado Design Suite User Guide: Designing IP Subsystems using IP
Integrator (UG994) [Ref 5],

"An interface is a grouping of signals that share a common function. An AXI4-Lite master,
for example, contains a large number of individual signals plus multiple buses, which are
all required to make a connection. If each signal or bus is visible individually on an IP

symbol, the symbol will be visually very complex. By grouping these signals and buses into
an interface, the following advantages can be realized. First, a single connection in IP

integrator (or Tcl command) will make a master to slave connection. Next, the graphical
representation of this connection will be simple - a single connection. Finally, Design Rule
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Checks (DRCs) that are aware of the specific interface can be run to assure that all the
required signals are connected properly.”

In the simplest case, an interface can contain one signal, such as CLOCK, DATA or RESET.

TIP: To view the interfaces available in the Vivado® Design Suite, select Window > IP Catalog, and
O click the Interfaces tab.

By specifying a defined interface, the PR Decoupler can create the appropriate code for all
signals in the interface. For example, Figure 2-2 shows a full decoupler when the
AXI4-Streaminterface is selected.

tp_tvalid o T~
> s_tvalid
0—»
ﬁ s_tready
rp_tready =
I
rp_tdata L
» s _tdata
0x00000000 —= (
rp_tuser >
» s _tuser
0x00000000 —— (
rp_tid >
»s_tid
0x00 ———» (
rp_tdest >
s tdest
0x00 — /
rp_tstrb L \L
» s _tstrb
0x0———» (
rp_tkeep >
» s_tkeep
0x0——» /(

o
D
o
[}
c
T
(0]

X14895-082115

Figure 2-2: Fully Decoupled AXI4-Stream Interface
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The decoupling behavior for each decoupled interface can be customized. With the
exception of the AXI4 interfaces listed Table 2-1, all signals in each interface are present and
decoupled to 0. Decoupling all signals in an interface can waste resources, so the common
interfaces in Table 2-1 have different defaults.

Table 2-1: AXI4 Interfaces Decoupling Exceptions

Interface Signal Decoupling Behavior
AXI4-Stream Only the TVALID and TREADY signals are decoupled.
TID, TDEST, TSTRB, TUSER and TKEEP signals are not present by default.
AXI4-MM Only the channel VALID and READY signals are decoupled.

The channel USER, LAST, ID, LOCK, CACHE, PROT, REGION and QoS signals are not
present by default. Additionally, when the PROTOCOL parameter is set to:

« AXIALITE - the following signals are disabled: AWLEN, ARLEN, AWSIZE, ARSIZE,
AWBURST, ARBURST, AWLOCK, ARLOCK, AWCACHE, ARCACHE, WLAST and
RLAST.

» AXI3 - the following signals are fixed to 4 bits wide: AWLEN and ARLEN.
+ AXI4 = the following signals are fixed to 8 bits wide: AWLEN and ARLEN.
* [None = no restrictions are applied.

Figure 2-3 shows the default implementation for an AXI4-Stream decoupler.

rp_tdata » s _tdata

rp_tvalid > \
» s tvalid
0—»
ﬁ - s_tready
rp_tready -=
7\4— 0

decouple
X14896-082115

Figure 2-3: Default Decoupling for AXI14-Stream Interfaces

The examples given so far have shown a decoupler that decouples a master interface on a
Reconfigurable Partition. A master interface is one which initiates transactions, and a
slave interface is one that responds to transactions. In the case of an interface with one
signal, the master interface is the one that drives the signal, and the slave interface is the
one that receives the signal.
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The PR Decoupler IP can also decouple slave interfaces on a Reconfigurable Partition, as

shown in Figure 2-4.

Reconfigurable

Partition Decoupler
~  pDATAtdata— s DATA tdata )
rp_DATA _tvalid —»\
AXI14- ———-m s_DATA_tvalid <to static>
Steog - < o— 1
DATA
ra—— s DATA_tready
rp_DATA_tready -«—
je——0
— _J
( rp_RESULT_tdata s_RESULT_tdata )
[e——— s RESULT_tvalid
AXI4- rp_RESULT avalid <+—— <from static>
Stream
Slave - < [e——0 > —
RESULT
rp_RESULT tready ———|
——» s RESULT_tready
A -
decouple

X14897-082115

Figure 2-4: Decoupling a Master and a Slave AXI4-Stream Interface

Figure 2-4 also shows that one instance of a decoupler cansdecouple multiple
Reconfigurable Partition interfaces. These can be of any interface type.

Control and Status

Control

The PR Decoupler IP provides several ways to control decoupling:

+ The decouple signal: The decouple signal input to the PR Decoupler IP is not
registered, so it directly controls the multiplexors in the decoupler. Set to 1 to enable
decoupling, and set to 0 to disable decoupling from this interface.
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« The AXI4-Lite interface: The AXI4-Lite interface provides access to a register that
holds the control value to use. A write of 1 to the control register enables decoupling,
and a write of 0 to this register disables decoupling from this interface.

« The AXI4-Stream interface: The AXI4-Stream interface provides access to a register
that holds the control value to use. A write of 1 to the control register enables
decoupling, and a write of 0 to this register disables decoupling from this interface.

These can be enabled in any combination, as long as at least one is enabled (see Table 2-2).
The value used internally to control decoupling is the OR of all of these interfaces.

Table 2-2:< Decoupling Control Combinations

AXI4-Stream Interface AXIl4-Lite Interface Decouple Signal Decoupling
0 0 0 Off
= - 1 On
- 1 - On
1 - - On

Figure 2-5 shows how these control interfaces combine to control the decoupling.

rp_A >
—» s A
0 —»
L4
AXl4-Lite =t=—l —
AX14-Stream —1—> —:Di
decouple

X14898-082115

Figure 2-5: PR Decoupler With All Control Options Enabled
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Status
The PR Decoupler IP provides several ways to get the status of the decoupling:

« The decouple_status signal: The decouple_status signal output from the PR

Decoupler IP is not registered, so it gives the immediate status of the decoupling. This
can be used to control other PR Decouplers.

« The AXI4-Lite interface: The AXI4-Lite interface provides access to a register that
holds the decoupling status.

« The AXI4-Stream interface: The AXI4-Stream interface provides access to the
real=time value of the decoupling status.

These can.bé enabled in any combination. You can have no status interfaces enabled.
Figure 2-6 shows@PR Decoupler with all of the control and status interfaces enabled.

rp_A -
—» s A
0 —»
e
AX|4-Lite & L
AXI4-Stream — ——»
P AXI4-Stream
decouple » <decouple_status

X14899-082115

Figure 2-6: PR Decoupler With All Control and Status Options Enabled

Additionally, each interface with Clock Domain Crossing enabled automatically gets an
output status signal called <interface name>_decouple_status. This shows the value
of the decoupling status in the interface's clock domain.
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Decoupling Using Global Routing

By default, all signals selected for decoupling are decoupled using a LUT inferred by the
Vivado tools. If the signal being decoupled is either a clock or a signal that needs to remain
on the global routing network, the decoupler can be configured to use a BUFGCE or a
BUFGCTRL primitive to implement the multiplexing.

« The BUFGCE primitive provides glitch free decoupling, but decoupling only takes effect
after thé.input signal switches to the decoupled value. The BUFGCE primitive should
onlysbe used for clocks.

« The BUFGCTRLyprimitive provides instant decoupling, but it is not guaranteed to be
glitchefree because the IGNOREO input is tied to 1. For more information, see the
appropriate clocking guide: 7 Series FPGAs Clock Resources (UG472) [Ref 12], or
UltraScale Architecture Clock Resources (UG572) [Ref 13].

If location constraints are required for these primitives, the instance name is constructed as
follows:

b_<interface name>»s<interface name>_<signal name>_<bit>_bufgce
b_<interface name>.<interface mame>_<signal name>_<bit>_bufgctrl
In the case of single bit signals, <bit> is'0.

For example, for an interface called intf_0 that contained a clock called CLK, the name
would be:

b_intf_0.intf_0_CLK_0_bufgce

Clock Domains

If the clock used to generate signals for a decoupled interface is differént from the clock
that manages the decoupler's control interfaces, clock domain crossing can,be enabled for
that interface. When clock domain crossing is enabled, a reference clock input for the
decoupled interface is added to the core's port map. This provides the clock to use for the
secondary stages of the clock domain crossing synchronizer.

The clock for the primary stage of the clock domain crossing synchronizer is the AXI clock
if available. If the AXI clock is not present (because all of the AXI4-Stream and AXI4-Lite
interfaces are disabled), a reference clock called decouple_ref_clk is enabled on the
port map, and that is used to clock the primary stage of the clock domain crossing
synchronizer.
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Example 1

Figure 2-7 shows a decoupler for an AXI4-Slave interface which requires no clock domain
crossing.

rp_DATA_tdata » s DATA_tdata

Y

TN/

rp_DATA_tvalid

» s DATA tvalid
0—»

s_DATA_tready

rpoDATA _tready, -

decouple
X14900-082115

Figure 2-7: Example 1 With No Clock Domain Crossing

Figure 2-8 shows the same example, bt withva three-stage clock domain crossing
synchronizer. Because there is no AXI clock in this example, a reference clock for the control
interface is automatically included.
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\

rp_DATA_tdata s_DATA_tdata

rp_DATA _tvalid >

» s DATA_tvalid
0o—»

s_DATA _tready
rp_DATA_tready

A

DATA_decouple_status

\/

\

T \S_/

DATA ref_clk

Y

Y

decouple_ref clk

decouple

X14901-082115

Figure 2-8: Example 1 WithThree Stages of Clock Domain Crossing

Example 2

Figure 2-9 shows a more complex decoupler without'clockidomain crossing. This decoupler
handles an AXI4-Stream interface called DATA and a FIFO Wirite channel interface called
FIFO.
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\/

rp_DATA_tdata s_DATA_tdata

\

A/

rp_DATA _tvalid

\

s_DATA tvalid
0 —

s_DATA_tready

A

rp_DATA_tready

\

ro_FIFO_WR_DATA s_FIFO_WR_DATA

rp_FIFO_WR_EN A
» s FIFO_WR_EN
0 —»
ﬁ -« s_FIFO_FULL
rp_FIFO_FULL =
~— [+— 0
'y
AXl4-Lite =11
—
- » decouple_status
AXI4-Stream . ple_
aclk >
decouple

X14902-082115
Figure 2-9: Example 2 With No Clock Domain Crossing

Figure 2-10 shows the same example, but with a three-stage clock domain crossing
synchronizer on the DATA interface and a two-stage clock demain crossing synchronizer on
the FIFO interface. Both of these interfaces have their own reference clock
(DATA_ref_clk and FIFO_ref_clk) but decouple_ref_clk.s not'needed in this
example because there is already an AXI clock for the control interfaces.
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\

rp_DATA_tdata s_DATA_tdata

rp_DATA_tvalid

\

\

s _DATA _tvalid
0 —»

s_DATA_tready

A

rp_DATA_tready

» DATA_decouple_status

DATA ref_clk

T\

YVyvY

i
P FIFO: WR_DATA » s FIFO_WR_DATA
fp_FIFO"WR_EN A
> s FIFO_WR_EN
- s_FIFO_FULL
rp_FIFO_FULL =
ﬁ\<_ 0
» FIFO_decouple_status
FIFO_ref _clk >
AXI4-Lite | — A
-
AXI4-Stream > @ » decouple_status
aclk >
decouple

X14903-082115

Figure 2-10: Example 2 With Clock Domain Crossing Enabled

Use Cases

This section shows various use cases for the PR Decoupler IP.

One PR Decoupler Per Reconfigurable Partition

In the use case shown in Figure 2-11, one decoupler instance is used to manage all of the
interfaces that exist between a Reconfigurable Partition and the static logic.
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AXl4-Stream Master

DATA

AXl4-Stream Slave

RESULT

BRAM Master

MEM

—pp <to static>

Decoupler
| gp— <from static>

- <t0 static>

|

decouple
X14904-082115

Figure 2-11: One PR Decoupler Per Reconfigurable Partition

Multiple PR Decouplers per Reconfigurable Partition

There is no need to have only one decoupler instance per.Reconfigurable Partition. It might
be easier to use multiple decouplers. For example, it ' mightibe'desirable to have:

1. One decoupler per interface (see Figure 2-12).

2. One decoupler for all master interfaces, and one for all slave interfaces.

3. One decoupler of each interface type, regardless of interface mode (seesFigure 2-13).
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AXl4-Stream Master

DATA
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A
decouple

decouple_status

AXl4-Stream Slave

RESULT
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) decouple
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B Decoupler —P <io static>
MEM
decouple
X14905-082115
Figure 2-12:( One PR Decoupler Per Interface
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Reconfigurable
Partition

AXI4-Stream Master

—| - <tO static>
DATA

Decoupler

AXIl4-Stream Slave

— ~@—— <from static>
RESULT

A
decouple

decouple_status

BRAM Master
| Decoupler — <to static>

T

AXI4-Lite

MEM

X14906-082115
Figure 2-13: QOne PR Decoupler Per Interface Type

Other use cases are possible as well. The'exact use case you use might be influenced by
such things as:

« A desire to reduce the number of IP instances.in a.design.
« The ease of layout in the Vivado IP integrator.
« The ease of declaration and connection in HDL-based/designs.

« The speed and ease of configuring many small decouplérinstances; versus one large
decoupler.

*  Whether phased decoupling is required (see Phased Decoupling):

When multiple decouplers are used per Reconfigurable Partition, one can be designated as
a master and the rest as slaves. The master decoupler is controlled by you, and the slaves
are controlled by the decouple_status output of the master decoupler or of other
slaves.

Figure 2-12 shows the bottom decoupler as the master decoupler, and in this case each
slave decoupler is controlled by the decoupler next to it. The master decoupler can use any
control interface type that is appropriate to the design. Figure 2-13 shows an AXI4-Lite
interface being used.
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Phased Decoupling

You might need to decouple/recouple different interfaces in a Reconfigurable Partition at
different times. An example of this is to recouple the clock and reset inputs to a
Reconfigurable Partition so that the Reconfigurable Module can be put into reset before
the other interfaces are recoupled. Figure 2-14 shows this being handled with two
independently controlled signals (decouple_early and decouple_late). Figure 2-15
shows this with one control signal and a two-clock cycle delay between the master
decoupler and the slave decouplers.

Reconfigurable
Partition

AXl4-Stream Master

. Decoupler —1b i1 static>
DATA

A decouple

decouple_status

AXl4-Stream Slave
- —————— Decoupler <— <from static>
RESULT

decouple_late

Clock & Reset |y Decoupler < <from static>

!

decouple_early

X14907-082115

Figure 2-14: Phased Decoupling With Independent Control'Signals
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Reconfigurable
Partition

AXl4-Stream Master
———— Decoupler —_ <to static>
DATA

A
decouple

decouple_status

AXI4-Stream Slave
B —— Decoupler ~—— <from static>
RESULT
decouple
* decouple_status
Clock & Reset — Decoupler ~&— <from static>
decouple

X14908-082115

Figure 2-15: Phased Decoupling With One Control Signal and a Delay Line

Integration with the Partial Reconfiguration Controller

The PR Decoupler IP has been designed to operatewith the Partial Reconfiguration
Controller IP, as shown in Figure 2-16. The rm_decoudple output of the appropriate Virtual
Socket Manager can be connected directly to the decouple control signal of the PR
Decoupler core. If multiple decouplers are used, it can"be onnected to each decouple
control signal directly, or the decouplers can be configured asishown in the master and
slave use case, as previously discussed.
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AXIl4-Stream Master

— —fp- <tO static>
DATA

AXIl4-Stream Slave Decoupler

 —————— |- «g— <from static>
RESULT

BRAM Master

———— f—pp- <tO static>
MEM

decouple

PRC

vsm_<name>_m_decouple

X14909-082115

Figure 2-16: PR Decoupler Controlled by the Partial Reconfiguration Controller

Performance and Resource Utilization

For full details about performance and resource utilization, visit the Performance and
Resource Utilization web page.
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Port Descriptions

The port map of the PR Decoupler IP is dynamically created to match the configuration of
the core. The following tables describe the ports:

» Table 2-3 shows the control and status ports. All of these are optional.

« Table 2-4 shows the ports for a single decoupled interface. Each PR Decoupler can
decouple multiple interfaces.

Table 2-3: Control and Status Port Descriptions

Name Direction Description
aclk Input Rising-edge clock used for the AXI4-Lite and AXI4-Stream interfaces.
s_axi_reg_arésetn Input Synchronous active-Low reset for the AXI4-LITE interface.
s_axi_reg_awaddr Input Standard 1-bit wide AXI4-Lite signal for the optional register
interface.
s_axi_reg_awvalid Inpat Standard AXI4-Lite signal for the optional register interface.

s_axi_reg_awready | Output | Standard AXI4-Lite signal for the optional register interface.

s_axi_reg_wdata Input Standard 32-bit wide AXI4-Lite signal for the optional register
interface. Only bit O is used.

s_axi_reg_wvalid Input Standard AXI4<Lite signal for the optional register interface.

s_axi_reg_wready Output | Standard AXI4-Lite signal for the optional register interface.

s_axi_reg_bresp Output | Standard 2-bit wide AXI4-Lite signal for the optional register
interface.

s_axi_reg_bvalid Output Standard AXI4-Lite 'signal‘for the optional register interface.

s_axi_reg_bready Input Standard AXI4-Lite signal forithe optional register interface.

s_axi_reg_araddr Input Standard 1-bit wide AXI14-Litessignal for the optional register
interface.

s_axi_reg_arvalid Input Standard AXI4-Lite signal for the optional registér interface.

s_axi_reg_arready Output | Standard AXI4-Lite signal for the optional registerdinterface.

s_axi_reg_rdata Output | Standard 32-bit wide AXI4-Lite signal for'the optienal register
interface. Only bit 0 is used. Other bits return 0.

s_axi_reg_rresp Output | Standard 2-bit wide AXI4-Lite signal for the optional register
interface.

s_axi_reg_rvalid Output | Standard AXI4-Lite signal for the optional register interface.

s_axi_reg_rready Input Standard AXI4-Lite signal for the optional register interface.

m_axis_status_tvalid | Output Standard AXI4-Stream signal for the optional AXI4-Stream status
channel.

m_axis_status_tdata | Output | Standard 32-bitwide AXI4-Stream signal for the optional AXI4-Stream
status channel. Only bit 0 is used. Unused bits return 0.

s_axis_ctrl_aresetn Input Synchronous active-Low reset for the AXI4-Stream Control channel.
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Table 2-3: Control and Status Port Descriptions (Cont’d)

Name Direction Description

s_axis_ctrl_tvalid Input Standard AXI4-Stream signal for the optional AXI4-Stream control
channel.

s_axis_ctrl_tready Output | Standard AXI4-Stream signal for the optional AXI4-Stream control

channel.
s_axis_ctrl_tdata Input Standard 32-bit wide AXI4-Stream signal for the optional AXI4-Stream
control channel. Only bit 0 is used.
decouple Input Active-High control signal. When asserted, decoupling is enabled.
decouplelstatus Output | A single-bit signal giving the decoupled status of the core. Can be

optionally enabled and disabled.

decouple_refclk Input A reference clock for the decouple control signal. Automatically
enabled when clock domain crossing is required and there are no AXI
interfaces enabled. Disabled otherwise.

In Table 2-4, <name>sis‘a user-defined name for the interface being decoupled. For
example, rp_<name>_data could be:

« rp_fifo_data, where <name> = fifo.
« rp_counter_data, where <name> = counter.

Table 2-4: Per-Interface Port Descriptions

Name Direction Description
rp_<name>_<signal> Input or A signal <signal> in interface <name> that is to be attached
Output to the Reconfiglrable Partition.
s_<name>_<signal> Input or A signal <signal> in‘interface <name> that is to be attached
Output to the static logic
<name>_ref_clk Input A reference clock forinterface <name>. Automatically

enabled when clock.domainscrossing is required for this
interface. Disabled othenWwise.

<name>_decouple_status | Output The decouple status for interface <name>. Automatically
enabled when clock domain crossing is required for this
interface. Disabled otherwise.
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Register Space

The PR Decoupler core register space is summarized in Table 2-5.

Register Address Map

Table 2-5: Register Summary

Address Space Offset

Name

Description

00h

CONTROL

Control register

00h

STATUS

Status register

RegisterDetails

CONTROL (Control Register - Offset 00h)

The CONTROL register isiwrite only, and is mapped to the same address as the STATUS

register.
Table 2-6: Control Register Format
Bits Meaning Details
31:1 Reserved Reserved
0 CMD 1: Turn decoupling on
0: Turn decouplingfoff

STATUS (Status Register - Offset 00h)

The STATUS register is read only and is mapped to the same address as the CONTROL

register.
Table 2-7: Status Register format
Bits Meaning Details
311 Reserved Reserved
0 STATE 1: Decoupling is enabled
0: Decoupling is disabled
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Designing with the Core

Chapter 3

This chapter includes guidelines and additional information to facilitate designing with the

core.

Findinga Suitable Interface

The Vivado® Design Suite provides many pre-defined interfaces which can be viewed from
the Interface Catalog window in the Vivado Integrated Design Environment (IDE)

(Figure 3-1).

O TIP: To open the Interface Catalog winhdow, select Window > IP Catalog, and click the Interfaces tab.

Cores  Interfaces

- Hame 1 'varsion

Yendaor

WLMY

iy $-= Vivado Repository
= @5 Advanced

—{b acc_fifo_read 1.0

= —{ll} acc_fifo_write 1.0
= | —{l} acc_handshake 1.0
% —{l acemm 1.0

Kilin®ecom
#ilinx.com
®ilinx. carm
¥ilin¥.com

¥iling. com:interface:acc_fifo_read: 1.0
®iling. com:interface: acc_fifo_write: 1.0
®iling. com:interface:acc_handshalke: 1.0
¥ilinx. com:interface;acemm: 1.0

Figure 3-1: Interface Catalog/Window

Double-click an interface in the Interface Catalog (Figure/3-1) to'open a window that
contains more information about the interface (Figure 3-2).

Details é
Marme: acc_handshake
Wersion: 1.0
Description: Arcelerator Handshake Interface
YWendor: xilink. com
WL ¥iling. com:interface;acc_handshake: 1.0

Extends WLkY:
Max Masters; 1

Max Slawes: 1
Figure 3-2: Interface Details Pane
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Creating a Suitable Interface

If none of the existing interface types are suitable for your application, you have two
options for creating a suitable interface.

The first option is to create an interface definition in the Vivado IDE by selecting Tools >
Create Interface Definition. This is a useful approach if you need to use the interface in
multiple decouplers.

The second option is to create an ad-hoc interface in the decoupler using the PR Decoupler
customization page or configuration properties. To do this, create an interface of type
undefiand add signals that you require, as shown in Figure 3-3.

Intarface Options

Interface to Canfigure |custom (unclef)
Interface Marme |cust0m
Interface WLk |undef

The Protocol overlay 1o apply 1o the WLNY

Interface Maode at EP |Master

Mumber of COC Stages |0

Signal Options

Mew signal name | signal_2| | | #dd Mew Signal
Mame Present Deletej ___ Direction at the RP
signal 1 - ¥ O 85 defined in the inter

&l

T —

Figure 3-3: Creating an Custom “Undef” Interface

Clocking

There are four clocking scenarios possible with the core:

S

The instance has no clocks.
The instance has a single AXI clock.
The instance has a single AXI clock and one or more interface reference clocks.

The instance has a single reference clock for the decouple control signal, and one or

more interface reference clocks.
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Scenarios 3 and 4 occur when the clock used to drive the control interface(s) is different
from the clock used to generate signals to be decoupled. In this case, clock domain crossing
hardware is enabled and reference clocks are required. These scenarios are discussed in
detail in Clock Domains in Chapter 2.

Each clock on the core’s interface(l), whether it is a control clock, a reference clock, or a
clock to be decoupled, has a parameter FREQ_HZ which can be used to set the clock’s
frequency. When the core is generated in out-of-context mode, these frequencies are used
to set clock constraints on the core instance. These frequencies are also used in IP
integrator for error checking.

The property names are defined as:
CONEIG«<clock name>.FREQ_HZ
where <cloek name>\is one of:

+ aclk_cLoCKsforithe AXI control interface clock.

¢ decouple_ref c¢lk €LOCK for the decouple signal interface reference clock.

Some examples are found,inTable 3-1.

Table 3-1: Property Names Examples

Property Name Description
CONFIG.aclk_CLOCK.FREQ_HZ The AXI control interface clock.
CONFIG.intf_0_CLK_CLOCK.FREQ_HZ Alclock called CLK in an interface of type

xilinx.com:signal:clock_rtl:1.0 called intf_O.

These properties can be set using the standard Vivado set_property command.
Additional constraints might be required when decoupling clocks using a BUFGCE primitive
or a BUFGCTRL primitive. The Vivado tools treat the data inputs to'these primitives as
clocks, so the relationship between the data input and its control input (the decouple
signal) might need to be defined using constraints.

Resets

The core has two reset signals:

« s_axi_reg_aresetn: An active-Low reset for the AXI4-Lite interface.

« s_axis_ctrl _aresetn: An active-Low reset for the AXI4-Stream control interface.

1. A clock is a signal within an interface of type xilinx.com:signal:clock_rtl. No other signal gets a FREQ_HZ parameter, even if
it is named to look like a clock.
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These signals are only present on the core boundary when the appropriate interfaces are
enabled. They only need to be asserted for a single clock cycle to take effect.
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Chapter 4

Design Flow Steps

This chapter describes customizing and generating the core, constraining the core, and the
simulation; synthesis and implementation steps that are specific to this IP core. More
detailed information about the standard Vivado® design flows and the IP integrator can be
found in the following Vivado Design Suite user guides:

« Vivado Design.Suite User Guide: Designing IP Subsystems using IP Integrator (UG994)
[Ref 1]

« Vivado Design‘Suite User Guide: Designing with IP (UG896) [Ref 5]
» Vivado Design Suite User'Guide: Getting Started (UG910) [Ref 6]
« Vivado Design Suite User Guide: Logic Simulation (UG900) [Ref 7]

Customizing and Generating the Core

This section includes information about usingXilinx® tools to customize and generate the
core in the Vivado Design Suite.

If you are customizing and generating the core in the Vivado IP integrator, see the Vivado
Design Suite User Guide: Designing IP Subsystems using IP Integrator (UG994) [Ref 1] for
detailed information. IP integrator might auto-compute certain configuration values when
validating or generating the design. To check whether the values do change, see the
description of the parameter in this chapter. To view the parameter value, run the
validate_bd_design command in the Tcl console.

You can customize the IP for use in your design by specifying values for the various
parameters associated with the IP core using the following steps:

1. Select the IP from the Vivado IP catalog.

2. Double-click the selected IP or select the Customize IP command from the toolbar or
right-click menu.

For details, see the Vivado Design Suite User Guide: Designing with IP (UG896) [Ref 5] and
the Vivado Design Suite User Guide: Getting Started (UG910) [Ref 6].

Note: Figures in this chapter are illustrations of the Vivado Integrated Design Environment (IDE).
The layout depicted here might vary from the current version.
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Validation Tab

This tab is available on the left of the core customization page. The Validation tab lists any
errors that remain with the current configuration. The core cannot be generated until all
listed errors are fixed. When the configuration contains no errors, the tab displays the text
“There are no errors."

Information Tab

This tab is_available on the left of the core customization page. The Information tab
provides‘the following information:

« The number of BUFGCTRL primitives used by the core instance. Because BUFGCE
primitives afe just BUFGCTRL primitives configured in a certain way, they are included
in this count.

« The currently selected, interface type.
« The signals that'are enabled in the interface and if they are decoupled.

« The signals that are disabled in the interface.

Global Options

This tab is available on the right of the core customization page. The Global Options tab is
used to configure the parts of the core that do not depend on the number of interfaces, or
their configuration. The following options ared@available:

« Enable the AXI4-Lite Interface: Enables or disables the AXI4-Lite register interface.

+ Enable the AXI4-Stream Control Channel: Enables or disables the AXI4-Stream
control channel.

 Enable the AXI4-Stream Status Channel: Enables or/disables the AXI4-Stream status
channel.

« Enable the Decouple control signal: Enables or disables the découple control signal.

« Enable the Decouple status signal: Enables or disables the decoupleistatus signal.
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Interface Options

This tab is available on the right of the core customization page. The Interface Options tab
is used to configure the interfaces that the PR Decoupler core manages.

The tab is split into three areas which are discussed separately:

1. Control Buttons
2. Interface Options

3. Signal©Options

Global Options sInterface Options

. 1
| MNew Interface Delete Interface
Interface Options y N 2
Interface to Configure |intf 0 (Alingcom:interface: aximm rtl: 1.0) hd |
Interface Name |intf_0 |
Interface WLNY |xilinx.com:interface:aximm rli:1.0 - |
The Protocol overlay to apply to the WLNY |A><I4 hd |
Interface Mode at RP |Master - |
MNumber of COC Stages |0 hd |
—_ —
Signal Options y y N 3
Mame Present Direction at the EP V mﬁ thits) | Decouple Decouple Yalue (hex) Fesaurce Type
ARVALID h ¥ As defined in the interface specification v | 1 ] |0x0 |Infer h
ARREADY = ¥ As defined in the interface specification > |1 | ¥ |0x0 |Infer h
AWVALID h ¥ As defined in the interface specification |1 | ) |0x0 |Infer h

Figure 4-1: Core Customization Page Layout

Control Buttons

There are two control buttons available, one of which is automatically’hidden when not
required:

« New Interface: Click this button to add a new interface to the core.

« Delete Interface: Click this button to delete the currently selected interface. This
button is only available when an interface is selected.

Interface Options

« Interface to Configure: This drop-down list contains the names of all the interfaces in
the core. Select the interface you want to configure.
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« Interface Name: This option contains the name of the selected interface. You can
change the text in this box to change the name of the interface. The name must satisfy
the following rules:

- Contains only letters, numbers or "_" (underscore).
. Does not start or end with "_" (underscore).
- Does not contain "__" (double underscore).

Note: The name change only takes effect when you click another control in the customization
page.

« Interface VLNV: Select the interface vendor, library, name, and version (VLNV)
definition to use for this interface. Selecting undef lets you define the interface signals
directly.

+ The ProtocolOverlay to Apply to the VLNV: Select the protocol to apply to this
VLNV. Protocols apply some restrictions, such as presence and width, to some of the
signals in the.interface. This is only enabled for AXI4-MM interfaces and is only
required to enable the'Vivado IP integrator to connect the AXI-MM interfaces correctly.
See Table 2-1 fordetails.

« Interface Mode at Reconfigurable Partition: Select the mode of the interface (master
or slave) at the reconfigurable partition boundary.

« CDC Stages: The number of synchfonization stages to use when crossing between
clock domains. Valid values are 0, 2,3, 4,.5, 6.

Signal Options

+ New Signal Name: Enter the name of the new signal to create. This option is only
available when the Interface Type is undef. The name must satisfy the following rules:

(underscore).

- Contains only letters, numbers or
- Does not start or end with "_" (underscore).
- Does not contain "__" (double underscore).

Note: The name change only takes effect when you click another controlin the customization
page.

« Name: [Read only] The name of the signal in each row of the table.

« Management: [In IP integrator only] Select between user managed (manual) and IP
integrator managed (auto).

« Present: Check the box to include the signal in the decoupler's port map. Uncheck the
box to not include the signal in the decoupler's port map.

« Delete: [Undef interfaces only] Check the box to delete this signal.
Note: This triggers the delete so the check mark never actually appears in the box.

« Direction: Chose the direction of the signal. The options are:
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- Input to the Reconfigurable Partition: Uses the signal as an input to the
Reconfigurable Partition regardless of the interface mode.

- Output from the Reconfigurable Partition: Uses the signal as an output from the
Reconfigurable Partition regardless of the interface mode.

- As specified in the interface definition: Use the direction specified in the
interface definition.

- Reversed from the interface definition: Use the reverse of the direction specified
in the interface definition.

«  Width: The width of the signal in bits.

« Decouple:Check this box to decouple the signal in Decouple mode. Uncheck this box if
the'signal should pass through in Decouple Mode.

« Decouple Value (hex): The signal is decoupled to this value. This field is not verified
against the width of the signal. The MSBs in the value that cannot map to bits in the
signal are quietlydignored.

« Resource Type: How the decoupling should be implemented for this signal. The
options are:

- Buffer: Use BUFGCTRL primitives to decouple each bit of this signal. This is not
glitch free but it allows decoupling to happen instantly.

o Clock Buffer: Use BUFGCE primitives to decouple each bit of this signal. This is
glitch free but the signal only becomesidecoupled when the input itself switches to
the decoupled value.

- Infer: Let the tools infer a primitive to use. This is typically a LUT regardless of
signal type or load.

User Parameters

Table 4-1 shows the relationship between the fields in thewivado IDE and the User
Parameters (which can be viewed in the Tcl Console).

Table 4-1: Vivado IDE Parameter to User Parameter Relationship

Vivado IDE Parameter/Value() User Parameters/Value() Default Value
Enable the AXI4-Lite Interface HAS_AXI_LITE 0
Enable the AXI4-Stream Control Channel | HAS_AXIS_CONTROL 0
Enable the AXI4-Stream Status Channel HAS_AXIS_STATUS 0
Enable the Decouple Control Signal HAS_SIGNAL_CONTROL 1
Enable the Decouple Status Signal HAS_SIGNAL_STATUS 1
Interface to Configure No equivalent User Parameter
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Table 4-1:

Chapter 4:

Vivado IDE Parameter to User Parameter Relationship

Design Flow Steps

Vivado IDE Parameter/Value()

User Parameters/Value()

Default Value

Interface Name

No equivalent User Parameter. The name of
each Interface is specified as part of the user
parameter name (shown as <i_name>
below)

DECOUPLED (0, 1)

Interface VLNV INTF.<i_name>.VLNV() undef
Note: This parameter is case sensitive.
Protocol to apply to the VLNV INTF.<i_name>.PROTOCOL AXI14 if the
VLNV is
AXIMM;
None
otherwise
Interface Mode at Reconfigurable INTF.<i_name>.MODE master
Partition
Master master
Slave slave
Number of CDC Stages INTF.<i_name>.CDC_STAGES 0
0,2, 3,4,5,6)
New Signal Name No equivalent User Parameter. The name of
each signal is specified as part of the user
parameéter name (shown as <s_name>
below)
Name (in Table) No equivalent User Parameter. The name of
each signal is specified as part of the user
parameter name (shown as <s_name>
below)
Present (in Table) INTF.<i_name> SIGNAL.<s_name>.PRESENT | Variable
Direction at the Reconfigurable Partition | INTF.<i_name>,SIGNAL.<s_name>. S
(in Table) DIRECTION
An input to the Reconfigurable in
Partition regardless of the interface
direction
An output from the Reconfigurable out
Partition regardless of the interface
direction
As defined in the interface s (short form “same”)
specification
Reversed from the interface r (short for "reversed”)
specification
Width (in Table) INTF.<i_name>.SIGNAL.<s_name>. Variable
WIDTH
Decouple (in Table) INTF.<i_name>.SIGNAL.<s_name>. Variable
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Table 4-1: Vivado IDE Parameter to User Parameter Relationship

Vivado IDE Parameter/Value() User Parameters/Value() Default Value
Decouple Value (in Table) INTF.<i_name>.SIGNAL.<s_name>. Variable
DECOUPLED_VALUE
Resource Type (in Table) INTF.<i_name>.SIGNAL.<s_name>. infer
RESOURCE
Buffer buffer
Clock Buffer clk_buffer
Infer infer
Management (in,Table). This is available | INTF.<i_name>.SIGNAL.<s_name>. auto
in IPdntegrator/only MANAGEMENT
Auto auto
Manual manual
Notes:

Parameter values are listed in the table where the Vivado IDE parameter value differs from the user parameter
value. Such values are'shown in-this table as indented below the associated parameter.

Configuring the Core'Using Tcl Commands

The Partial Reconfiguration Decoupler can be configured from the Tcl command line by
setting properties directly. A customisetdproperty command is generally required. The
following command must be executed.in the Vivado Tcl command line to access
pr_decoupler_vl1l_0::set_property:

source [get_property REPOSITORY \
[get_ipdefs
*pr_decoupler:1.0]]/xilinx/pr_decoupler_v1_ 0/tcd/api.tcl -notrace

Note: This can be placed in the Vivado Design Suite initialization file for ease of use.

Example 1: Decouple an AXI4-Stream master on the Reconfigurable Partition

create_ip -vlnv xilinx.com:ip:pr_decoupler:1.0 -module_name prd_0

pr_decoupler_vl_0::set_property -dict [list \
CONFIG.INTF.my_ intf.VLNV xilinx.com:interface:axis_rtl:1.0 '\
] [get_ips prd_0]

Example 2: Decouple an AXI4-Stream master on the Reconfigurable Partition
and an AXI4-MM slave on the Reconfigurable Partition

create_ip -vlnv xilinx.com:ip:pr_decoupler:1.0 -module_name prd_1
pr_decoupler_vl_0::set_property -dict [list\
CONFIG.INTF.intf_ 0.VLNV xilinx.com:interface:axis_rtl:1.0 \
CONFIG.INTF.intf_1.VLNV xilinx.com:interface:aximm_rtl:1.0 \
CONFIG.INTF.intf_1.MODE slave\
] [get_ips prd_1]
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Example 3: Decouple an AXI4-Stream slave on the Reconfigurable Partition
with TUSER enabled and decoupled

create_ip -vlnv xilinx.com:ip:pr_decoupler:1.0 -module_name prd_2

pr_decoupler_vl_0::set_property -dict [list \
CONFIG.INTF.intf_ 0.VLNV xilinx.com:interface:axis_rtl:1.0 \
CONFIG.INTF.intf_ 0.MODE slave \
CONFIG.INTF.intf_ 0.SIGNAL.TUSER.PRESENT 1 \
CONFIG.INTF.intf_0.SIGNAL.TUSER.WIDTH 32 \
CONFIG.INTF.intf_0.SIGNAL.TUSER.DECOUPLED 1 \
CONFIG.INTF.intf_ 0.SIGNAL.TUSER.DECOUPLED_VALUE OXFFFFFFFF \

] Jget_ips prd_2]

Interface parameters such as a reset's polarity (POLARITY) or a clock's frequency (FREQ_HZ)
should\be set'using set_property as normal.

Output Generation

The Partial Reconfiguration Decoupler delivers Synthesis and Simulation models as
standard. For details, see thewivado Design Suite User Guide: Designing with IP (UG896)
[Ref 5].

In addition, the core delivers a«onfiguration information text file containing useful
information about the core configufation. This can be accessed in the IP Sources tab of the
Vivado IDE in the instances synthesis group.

The text file can also be found on disk at:

<ip source dir>/documentation/configuration information.txt

To access the text file on disk, disable IP Core Containers, or extract the file using the
extract_files command.

This text file contains the following information:

« The property values used to configure the core.

« A command to regenerate the core as configured.

Constraining the Core

This section contains information about constraining the core in the Vivado Design Suite.

Required Constraints

The PR Decoupler core does not normally require user constraints. However, some
constraints might be required in certain circumstances, as detailed in this section.
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Device, Package, and Speed Grade Selections

The PR Decoupler works with any device supported by the Vivado Design Suite.

Clock Frequencies

When the core is used in an out-of-context mode, a constraints file is automatically
generated to constrain all relevant clocks to the frequencies specified using the instance’s
FREQ_HZ properties. You set these properties as described in Clocking.

When a signal.is decoupled using a BUFGCE or a BUFGCTRL, additional constraints might be
required by the tools, depending on how the instance is configured and how it is used in
the system. Missing constraints will be highlighted by warning messages during
implementation. For more details, see Clocking.

Clock Management

This section is not applicablesfor this IP core.

Clock Placement

When a signal is decoupled using.a BUFGCE or a BUFGCTRL, additional constraints might be
desirable to specify exactly which resources are used. For information on the instance
names of these primitives, see DecouplingUsing Global Routing.

Banking

This section is not applicable for this IP core.

Transceiver Placement

This section is not applicable for this IP core.

I/0 Standard and Placement

This section is not applicable for this IP core.

Simulation

For comprehensive information about Vivado simulation components, as well as
information about using supported third-party tools, see the Vivado Design Suite User
Guide: Logic Simulation (UG900) [Ref 7].
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ﬁ IMPORTANT: For cores targeting 7 series or Zynq®-7000 devices, UNIFAST libraries are not supported.
Xilinx IP is tested and qualified with UNISIM libraries only.

Synthesis and Implementation

For details about synthesis and implementation, see the Vivado Design Suite User Guide:
Designing with IP (UG896) [Ref 5].
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Chapter 5

Test Bench

This chapter contains information about the test bench provided in the Vivado® Design
Suite.

Demonstration Test Bench

When the core'is.generated using the Vivado Design Suite, a demonstration test bench is
created. This is a simple VHDL test bench that exercises the core.

The demonstration test bench source code is one VHDL file: demo_tb/
tb_<component_name>uvhd din-the Vivado output directory. The source code is
comprehensively commented.

Using the Demonstration Test Bench

The demonstration test bench instantiates the generated core. Compile the netlist and the
demonstration test bench into the work library (se€e your simulator documentation for more
information on how to do this). Then, simulate the demonstration test bench. View the test
bench signals in your simulator waveform viewer to seerthe operations of the test bench.
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Appendix A

Debugging

This appendix includes details about resources available on the Xilinx Support website and
debugging tools.

Finding/Help on Xilinx.com

To help in the designand.debug process when using the PR Decoupler, the Xilinx Support
web page contains key resources such as product documentation, release notes, answer
records, information‘about known issues, and links for obtaining further product support.

Documentation

This product guide is the main document associated with the PR Decoupler. This guide,
along with documentation related to all{products that aid in the design process, can be
found on the Xilinx Support web pagé orby using the Xilinx Documentation Navigator.

Download the Xilinx Documentation Navigator.from the Downloads page. For more
information about this tool and the features available, open the online help after
installation.

Answer Records

Answer Records include information about commonly encountered problems, helpful
information on how to resolve these problems, and any known issues with a Xilinx product.
Answer Records are created and maintained daily ensuring that usersshave access to the
most accurate information available.

Answer Records for this core can be located by using the Search Support box on the main
Xilinx support web page. To maximize your search results, use proper keywords such as

*  Product name
« Tool message(s)

« Summary of the issue encountered

A filter search is available after results are returned to further target the results.
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Master Answer Record for the PR Decoupler

AR: 65394

Technical Support

Xilinx provides technical support at the Xilinx Support web page for this LogiCORE™ IP
product when used as described in the product documentation. Xilinx cannot guarantee
timing, functionality, or support if you do any of the following:

« Implement the solution in devices that are not defined in the documentation.
« Customize the solution beyond that allowed in the product documentation.

« Changerany.section of the design labeled DO NOT MODIFY.

To contact Xilinx Technical Support, navigate to the Xilinx Support web page.

Debug Tools

There are many tools available to address'PR Decoupler design issues. It is important to
know which tools are useful for debugging various situations.

Vivado Design Suite Debug Feature

The Vivado® Design Suite debug feature insertsilogic.analyzer and virtual I/O cores directly
into your design. The debug feature also allows you to set trigger conditions to capture
application and integrated block port signals in hardware. Captured signals can then be
analyzed. This feature in the Vivado IDE is used for logic'debugging and validation of a
design running in Xilinx devices.

The Vivado logic analyzer is used with the logic debug IP cores, including:

« ILA 2.0 (and later versions)

« VIO 2.0 (and later versions)

See the Vivado Design Suite User Guide: Programming and Debugging (UG908) [Ref 9].
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Appendix B

Additional Resources and Legal Notices

Xilinx Resources

For supportsfesources such as Answers, Documentation, Downloads, and Forums, see Xilinx
Support.

References

These documents provide 'supplemental material useful with this product guide:

Partial Reconfiguration Controller LogiCQRE IP Product Guide (PG193)

Partial Reconfiguration in the Vivado'Design Suite page on Xilinx.com

1.
2.
3. Vivado Design Suite User Guide: Partial Reconfiguration (UG909)
4. Vivado Design Suite User Guide: Designing IP Subsystems using IP Integrator (UG994)
5. Vivado Design Suite User Guide: Designing with IP(UG896)
6. Vivado Design Suite User Guide: Getting Started (UG910)
7. Vivado Design Suite User Guide: Logic Simulation (UG900)
8. ISE to Vivado Design Suite Migration Guide (UG911)

9. Vivado Design Suite User Guide: Programming and Debugging {UG908)

10. Vivado Design Suite User Guide: Implementation (UG904)

11. LogiCORE IP AXI Interconnect Product Guide (PG059)

12. 7 Series FPGAs Clocking Resources User Guide (UG472)

13. UltraScale Architecture Clocking Resources User Guide (UG572)
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Revision History

The following table shows the revision history for this document.

Date Version Revision

04/06/2016 1.0 « Update core to production status.

« Update the "Unsupported Features" section to remove text that is no
longer relevant.

11/18/2015 1.0 Added support for UltraScale+ families.
09/30/2015 1.0 Initial Xilinx release.
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